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Section 3: Using the VitalStore Software 
 
The VitalStore software program is used to view and manage all of the recorded data from the 
VitalMonitor program. VitalStore is an independent program and can be run in conjunction with 
the VitalMonitor program or as a stand alone program. There are a number of ways to launch 
the VitalStore program: 
 

1) From the VitalMonitor program: 
Click on the “launch VitalStore” icon in the main top toolbar, or use the Tools menu  
 

 
 

2) From the Desktop. Double click the VitalStore 2.0 icon on the Desktop that was placed 
there during the installation process 

3) From Windows Start menu: Start/All Programs/Vetronic Services LTD/VitalMonitor V 
1.0.142/VitalStore 2.0 
 

 
 

Figure 28 
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VitalStore opens with a blank screen in the right hand area of the window. On the left is a 
Practice Management Panel. This Panel will contain any of the patients and clients already 
entered in the database in the VitalMonitor program. Associated with each patient is a list of 
files that have been saved during a monitoring session. The files listed with a patient may be in 
different colours, representing different states of the data. 
 

Black: Recorded and saved data 

Red: Data is currently being recorded 

Grey: Data was discarded or data saving was interrupted before normal program closure 
 
Files are saved in a standard format. The first few letters indicate the data type. This is followed 
by the date and time of the start of the recording. The data types are: 
 

ECG: ECG data 

BP: Blood Pressure data 

BD: Breath data, from IRMA breath monitor – CO2, O2, N2O & Agent, or from the simple 
Respiratory Monitor 

PLS: Pulse-Oximetry data 

TEMP: Temperature data 
 

For example, the data file ECG_22Apr08.33.47, is an ECG file recorded on the 22
nd
 April at 

08:33:47 in the morning. Files are stored in chronological order in the Practice Management 
panel under the animal name that they are associated with.  
 
A unique feature of VitalMonitor and VitalStore is that data can be viewed in VitalStore while a 
recording is in progress. If a recording is in progress (data file name in red) then data is 
available right up to the point where the file is opened.  While the data is being viewed in 
VitalStore, recording of new data will continue. This new data cannot be viewed in VitalStore 
without first closing the file and opening it again.  
 

The Practice Management Panel 
This left hand panel shows a tree structure of all folders, clients and patients on the database. 
After the initial installation this panel will be empty except for the ‘Root’ entry. From this root, 
folders, clients and patients can be added. For a detailed explanation on adding components to 
the Practice Management Panel see the section “Adding a Patient to the Patient Monitoring 
List” in the document “Getting Started with VitalMonitor”. 
The Practice Management Panel is the starting point for managing all the data associated with 
a client or patient. This is done through the Browse window. To open the Browse window, right 
click anywhere in the Practice Management Panel, or click on the folder icon at the top of the 
panel, next to the refresh icon. 
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The Browse Window 
 

 

 
The Browse window can be used for many tasks including searching for and opening files, 
updating patient and client details and renaming files as well as creating folders, clients and 
patients.  
The creation of folders, clients and patients is covered in detail in the “Getting Started with 
VitalMonitor” document. In summary, create a new level entry by clicking on an existing entry 
For example, to create a new patient for Holmes, click on Holmes in the left tree view and then 

click on the “create patient icon”   . Rename the new patient as appropriate.  
 

Editing and Viewing Patient Details 

 
To view the details for a patient, first select that patient by clicking on the name in the tree view. 
The files associated with that patient are then listed in the right pane. Then right-click and 
choose “Details” from the sub-menu that appears. Note that at this point it is also possible to 
Delete or Rename the patient. Also, patients cannot be deleted if they are currently being 
monitored. By clicking on Details a “Patient Detail” window appears. This window has two tabs.  
 
 
The first is called “General” and provides the following information:  

Name: the name of the patient. Edit this name in the normal way 

 

Tree  

View 
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Location: The full directory path to the patient 

Created: The time and date that the patient was created. 
 

Associating an image with a Patient 
In the Patient Detail window there is a space for an image that can be any image required, but it 
is probably most useful to place an image of the patient here. This image is used throughout 
the VitalMonitor & VitalStore software and will appear in the monitoring screen whenever that 
patient is monitored. To change the image, click on the “Change Picture” button and then 
navigate to find the required image.  
 
The second tab is called “Details” and holds the following information on the patient: 

Date of Birth: use the drop down box to select a date from the calendar 

Weight: enter the weight in kg 

Breed: enter the patient’s breed 

Species: enter the patient’s species 

Sex: enter the sex of the patient including neutering status e.g. Male (N) for neutered male 

Notes:  this field can be used for any general text information 
 
Any of these fields may be freely edited (unless the patient is currently being monitored) with 
the required information.  
  

Editing & Viewing Client details 
 
This information is accessed in the same manner as the patient details. First click on the client 
and then right-click to view the sub-menu. Choose Details from the sub-menu. A new window 
appears with three tabs: General, Address and Contact. Edit the fields in these tabs with the 
required information.  
 

Sorting the information in the Browse window 
In the top left-hand corner of the Browse window is a small icon and a drop-down list.  

 

 
 

The drop-down list gives three options in viewing the data: 

Show Recording: shows/hides the files currently being recorded 

Show Failed: shows/hides the files that have not been saved properly due to a system crash or 
other technical fault 

Show Purged: shows/hides the files that have been discarded or purged at the end of a 
recording session.  
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To prevent clutter and over-crowding the Patient Management Panel, keep “Show Failed” and 
“Show Purged” un-checked. 
 

Using the Refresh option in the Practice Management Panel 
Whenever changes have been made to the data in the 
Practice Management Panel or when new files have been 
created in VitalMonitor while VitalStore has been open, use 

the Refresh icon  to show the latest state of the 
information.  
 

 

 

Controlling the layout and what you see in VitalStore 
 

Practice Management Panel 
This can be closed at any time by clicking on the “Close” icon in the top right hand corner of the 
Panel.  

 
The panel can also be re-sized by grabbing the right-hand margin with the mouse and dragging  
to the required size:  

 

 
 

In the same manner that the Practice Management Panel can be resized, so can the Trend 
Window/Trace Window combination of ECG files. In the picture below the Trend Window has 

 



Section 3A: Using the VitalStore Software 
 - 8 - 

been reduced to a minimum to maximise the ECG view. Also the Data Information on the left of 
the ECG trace can be resized using a mouse to reduce its width.  
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Using the Full Screen Option 

 
To optimise the viewing of data, remove the Practice management Panel, minimize the width of 
the Data Information Panel and view the result using the Full Screen option.  
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Viewing Recorded Data 
To view data for a particular patient, navigate to the patient in the Practice Management window 
and double click on the file you wish to view. When the mouse is held over a patient’s data file 
the date and time that the file was created is shown in a small pop-up window.  
 

 
 
After selecting a file and double-clicking on it the file will open. The largest files are likely to be 
the ECG files as these contain the most data and these may take a while to load if the 
recording time has been for an hour or more. A progress bar indicates the time for opening the 
file.  
For an ECG file, the file will open to show a screen similar to this one: 
 

 

Figure 29 
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The right hand side of the screen now holds all of the ECG data and displays it initially in the 
Waveform window with a Trend window above it. The view is similar for different types of data 
and each data type will be described in turn in the following text. 
 

Main Window Common features 
For all data there is a scroll bar (highlighted above) along the bottom of the data that enables 
moving through the file. As the data is scrolled through, the time at the bottom left hand corner 
of the screen is updated. There is also a vertical scroll bar (highlighted above) that controls the 
vertical position of the trace. 
 
A toolbar under the main menu bar controls much of the behaviour of the VitalStore program 
and its windows. 
 
 

 
 
 
 
 
 
 
 
 

Toolbar icons 
 

1: Open File  Use ‘Open File’ to view file data without importing the data into the database. The 
client and patient information will not be shown in the Practice Management Panel  and some 
actions will be inhibited. For full functionality, Import the file. 

2: Print File Use this to access the printer setup options and for print preview 

3: Copy data to clipboard Regions of data can be selected using the left mouse button in the 
trace window. Once copied to clipboard this data is freely available to any windows program, 
such as Microsoft Word, Excel or Paint. 

4: Full Screen Shows the file data in the whole screen by removing the Practice Management 
Panel. Return to normal view by clicking on the “Full Screen” button in the top right hand corner 
of the screen next to the minimize and exit icons. 

5: Show Practice Management Panel  When the Practice Management Panel has been 
removed, use this icon to bring it back into view 

6: Turn Grid ON or OFF Use this icon to show or hide the background grid to a trace 

7: Trace Filter options (ECG only) This icon controls the filter that is applied (if any) to ECG 
data.  When a filter is applied it is indicated by the trace turning to red and a description of the 
filter level being shown in the Trace Window.  For a detailed explanation of ECG filters see the 
section “Filtering the ECG trace” 

8: Trace height and width arrows These 4 arrows control the size of the displayed trace in the 
Waveform view. When an arrow becomes greyed, it indicates the limit of that arrows function. 
Vertical arrows control the height of the displayed trace and horizontal arrows control the width 
of a displayed trace.  

1 

2 

3 

4 

5 

6 
8 

7 

9 

Figure 30 
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9: Event List viewer Clicking on this icon will open a list of events associated with the 
displayed trace. Double-clicking any event will cause the Trace Window to jump directly to that 
point of the trace.  
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ECG Data 

 

The Data Panel 
Starting with the left hand side of the data screen is a Data Panel that can show one of three 
types of data. This data is chosen by selecting the appropriate tab at the bottom of the screen. 
The options are Client, Patient and Data. 
 

The Client Tab displays information about the client that is currently held in the database. All 
the fields except the Client Name can be edited here. The changes are saved automatically. 

The Patient Tab displays information about the patient. All the fields except the Patient’s name 
can be edited here. The changes are saved automatically. 

The Data Tab is where the measurements on the ECG are recorded. This is covered more fully 
in the section “Measuring the ECG parameters” 
 

The ECG trace itself is shown in one of three windows. The options are the Waveform 

window, the Extended View window and the Multi-Trace window.  
Please note that there are different types of ECG modules that can record data in VitalMonitor. 
Only those modules that record 6-lead ECG data will have the option of the Multi-Trace window. 
For single-lead ECG modules the Multi-Trace tab is not shown. 
 
The Data Panel also has an area for writing any notes, comments or diagnoses that relate to 
the ECG and the patient. These notes are used during printing to form part of the first page of 
the ECG Report.  
 

The ECG Waveform Window 
The Waveform window shows the continuous ECG from the start of the recording on the left of 
the window to the end. The horizontal scroll bar at the bottom of the window can be used to 
scroll through the data and when this is done the time figure in the left hand corner updates the 
start time for the window. An optional grid shows height and time divisions for the window. To 
turn the grid ON, click on the grid icon at the top of the screen in the toolbar. 
 

 
 
Turn the grid OFF using the same button. 
Also on this toolbar are the height and width buttons for controlling the ECG display.  They are 
the blue arrows next to the grid button. Use these to increase or decrease the height of the 
ECG in the Waveform window, or to stretch or compress the ECG trace.  
 

Changing the Lead in the Waveform window 
For 6-lead ECG data there will be a drop-down option box in the top left area of the Data Panel 
window, just under the main toolbar. This drop-down menu allows the lead shown in the 
Waveform trace window to be changed to any of the 6 lead types. This option also controls 
what is seen in the Extended View window. 
 

 

Figure 31 
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Filtering the ECG trace 
There are no filters applied to the ECG data when a file is first opened. If there is noise present 
on the ECG trace then this can be removed or reduced by applying digital filters. By applying 
digital filters at a controlled level, the degree of filtering can be kept to a minimum to reduce the 
effect on the underlying ECG.  Clicking on the Filters icon in the main toolbar drops down two 
menu options:  a Filters option and a Settings option. Choosing the Filters option toggles the 
filters ON or OFF. Choosing the Settings option opens a new dialog box for fine control of the 
filter.  

 
 
To turn ON digital filtering click in the “Digital Filter On” box. The minimum filter applied is a 
level 1 filter. To see the effect on the ECG click on the Apply button. Change the filter level by 
dragging the top scroll bar along the slider and then click “Apply “ to see the changes. Choose 
between a Low Pass filter and a Notch filter using the radio buttons. For an explanation of the 
differences between a Low Pass filter and a Notch filter see the section on “Filters” in the 
VitalMonitor section of this guide.  When done click OK. 
A filtered ECG trace will be shown as a red trace in the Waveform window to indicate that it is 
filtered data. The type and level of filter applied is also shown at the top of the ECG trace. In a 
6-lead ECG the filter is applied equally to all 6 leads. 
  
 

Figure 32 
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Adding bookmarks to the ECG trace 
In the same manner that events can be added to the real-time ECG trace during recording, 
bookmarks can be added to the ECG trace under review. Bookmarks are always added after a 
recording has finished, events are always added while a recording is in progress. To add a 
bookmark to any point along the ECG trace, scroll to the point where you would like to add the 
bookmark and then click the right mouse button. A sub-menu pops up. Choose the “Add 
Bookmark Here” option to open a new dialog box: 
 

 
 
The bookmark is automatically given the name Bookmark by default and the cursor is placed in 
the Description edit box ready for typing the required text. The name of the bookmark can be 
changed if required and the bookmark saved and closed by clicking the OK button.  
 

Viewing all the events and bookmarks 
A list of events and bookmarks can be displayed by c clicking on the Event List icon in the main 
toolbar at the top of the screen (item 11 in the introductory diagram). The Event List can also be 
displayed from the View menu.  
 

Figure 33 
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The ECG Extended View window 
This window provides a quick means of looking at a lot of ECG data by presenting the data as a 
page of a single continuous Lead. The number of lines per page and the time span across the 
screen are user-controllable to allow up to 100 minutes of ECG data per page. For ECG’s 
longer than 100 minutes a scroll bar on the right of the screen allows additional pages to be 
viewed. In the example shown in Figure 34, the number of traces has been set to 10 and the 
time across the screen is set at 10 seconds. 
 

 
 
 
With the Extended View window, changes in rate and rhythm can quickly be appreciated 
 

Figure 34 
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Measuring ECG Parameters 
To measure any one of the 10 ECG parameters listed in the Data Tab window, first select the 
Data Tab window and then click on the first parameter to measure. 
For example to measure the R-R interval click on the R-R edit window in the Data Tab. The box 
turns yellow ready for the measurement: 
 

 
 
 
Place the mouse on the ECG trace and press and hold the left button. A yellow vertical line 
appears. Keeping the left mouse button held down, move the line to the first R-wave and then 
release the left mouse button. A second yellow line appears. Move this to the second R-wave 
and then press the left mouse button again. The measurement is made, the edit box turns white 
and displays the measured value.  
The process is the same for all measurements. Height measurements will use horizontal yellow 
line larkers and time measurements will use vertical yellow line markers.  
Any measurement can be repeated at anytime and the last measured value is held in the edit 
box.  
 
 
 

Figure 35 
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Printing and Report Generation 
 

Printing trace data 
Clicking on the print icon or using the menu option File/Print will open the Print Settings Dialog 
box ready to print the trace data. 
 
 

 
 
 
 

The Print Settings dialog box 
Print Sensitivity Panel 
This panel controls the height of the ECG as it is printed on the ECG paper. The ECG paper is 
printed as strips 50mm tall and the full width of the paper. Select the sensitivity to be 0.5, 1.0 or 
2.0 mV per cm.  
 
Print Speed Panel 
The ECG can be printed at four common speeds. 25mm/ second is a standard setting but the 
ECG can be printed at much higher speeds – up to 200mm/second. This will give the ECG the 
appearance of being stretched out across the page and is suitable for very fast heart rates. 
Select the print speed required.  
 
 
 
 
Print Range Panel 

Figure 36 
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There are 3 radio buttons in the Print Range panel and one edit box. The edit box shows the 
number of pages that will be printed including the Report page and Trend page (if selected).  
The “All”, “Pages” and “Selection” options refer to the ECG data. 
 

“All” - Prints the entire ECG the total number of pages is shown in the edit box added to the 
Report and Trend pages. 

“Pages” – Prints the number of pages selected in the edit box. The minimum number of ECG 
pages that can be selected for printing is 1. The edit box shows the number of ECG pages 
selected for printing plus the Report and Trend pages. 

“Selection” – Prints only the portion of ECG currently selected by the mouse. The print-out will 
always be one page wide if there is sufficient data to fill the page width. The left hand side of 
the page corresponds with the left border of the mouse selection.  
 
Print options Panel 
Choose whether to print the Report page, Trend page or pages of ECG trace by checking the 
check-boxes accordingly. The number of pages to print is updated and shown in the edit box in 
the Print Range panel.  
 

Report Page: This is the first page of an ECG report and holds the practice, client and patient 
details. It also shows the results of the measured ECG parameters and the reference normal 
values for that species. 

Trend: This draws the whole trend trace in the width of the selected page type and also prints a 
list of the events and bookmarks associated with that ECG trace. 

ECG Traces: These are the ECG traces and the way that ECG data is printed can be changed 
depending on whether 3-Lead, 6-Lead or just Lead II ECG data is required. To maintain 
synchronisation vertically within a printed page, only three ECG traces are printed per page. If 
the 3-Lead option is selected, then Lead I will be printed at the top of the page, Lead II 
immediately below it and Lead III immediately below that. If the 6-Lead option is selected then 
leads I,II and III will be printed on one page followed on the next page by the corresponding 
leads avL, aVR and aVF. If the Lead II only option is selected then the printed page will consist 
entirely of strips of Lead II data. 
 

Page Settings 
Use this button to set up the settings of the page such as paper orientation (Portrait or 
Landscape) margin width, paper size and other printer related settings. 
 

Preview 
Use this button to preview the report and associated pages.  
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Pulse-Oximeter Data 
 
Pulse-Oximeter data can be viewed by selecting a Pulse-Oximeter file (PLS file) belonging to a 
patient and double-clicking with the mouse.  
A new window opens to show the recorded data. There is no scale associated with the pulse 
waveform as it shows the relative magnitudes of the pulse waves only.  
The height and trace speed of the waveform can be altered in the normal way using the blue 
arrows at the top left of the data screen.  
Pulse-Ox waveforms can be copied to clip board by first selecting them using the mouse. To do 
this, hold down the left mouse button and drag the mouse to select the data within the blue 
rectangle. Then select Edit/Copy to Clipboard from the main menu bar. 
Use the Events icon to view a list of events for the recording. When the list of events is 
displayed, double click on any event to jump to that point in the file.  

 
  
 
 

IRMA Monitor Data 

 
IRMA monitor data can be viewed by selecting a Breath Data file (BD File) belonging to a 
patient and double-clicking with the mouse.  There are two types of Breath Data files, 
depending on the hardware device attached to your MultiMonitor. One type is produced by 
IRMA style monitors and will provide data on CO2, O2, N2O and Agent waveforms (with 
appropriate IRMA module). The data shows in the same format as ECG or Pulse-Ox data and 
has a main trace window showing each breath waveform. A vertical scale to the left hand side 
of this trace indicates the C gas concentrations.  
The height and trace speed of the waveform can be altered in the normal way using the blue 
arrows at the top left of the data screen.  
Breath Data waveforms can be copied to clip board by first selecting them using the mouse. To 
do this, hold down the left mouse button and drag the mouse to select the data within the blue 
rectangle. Then select Edit/Copy to Clipboard from the main menu bar. 
Use the Events icon to view a list of events for the recording. When the list of events is 
displayed, double click on any event to jump to that point in the file.  
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Exporting Data from VitalStore 2.0  

 
Data can be exported from VitalStore 2.0. This may be done for the following reasons: 
 

• To create a file that can be sent to a colleague or referral cardiologist 

• To create files that can be archived to another computer 
 

How to export a file from VitalStore 2.0 
 
In the VitalStore software click on the File menu and choose the Export option.  

 

An ‘Export Item’ dialog box appears. Choose the patient’s file that you would like to export. 
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Then click on the ‘Export’ button. A second dialog box appears. Use this dialog box to choose 
the destination of the exported file and to give it a name. 
 

 
 
It is not necessary to add the file extension to the file name, the software will do that 
automatically.  
The file is exported as a vse file, that can be copied, e-mailed and stored in the normal way.  
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Importing Data into the VitalStore Software 
 
ECG data can be imported in the following formats: 
 
 

• From another VitalStore 2.0 program 
 

• From a VitalStore 1.3 program 
 

• From a USB stick with data collected using the VitalStore MultiMonitor ECG unit 
 

• From a CardioStore program.  
 
 

Importing data into VitalStore 2.0 

To import a file select ‘Import’ from the main File menu. The following dialog will appear. This 
method is used whether it is a file from a USB stick or any other location.  

 

 

Select the VitalStore file required and then press ‘Open’ 

 

There are several types of import files, VitalStore 1.3, VitalStore 2.0, and CardioStore files. All 
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VitalStore export files, whatever the version, will have the file extemsion '.vse'. 

Importing a CardioStore file 

CardioStore files are not the detault file type, so in order to import a CardioStore file you must 
first select the 'File of type' drop down option and select CardioStore files. All CardioStore type 
files should then appear in the view as below. 

 

 
Once a file is selected and the ‘Open’ button is clicked, the application will gather information 
from the file before importing the data. The status bar at the bottom of the screen shows that 
the program is busy gathering information. 

 

 

 

 

 

 

 

With large import files this may take a little while. A wait cursor will also appear indicating that 
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the application is processing the file. 

A further dialog box will then appear. Now choose the destination of the import file. This can be 
the same details as the original file or can be to a new patient’s records. The information at the 
bottom of the Import Dialog box shows the names of the Client and Patient for the file to be 
imported.  

 

 

 
 
 
If the details of the client and patient are not shown in the left hand column then those details 
are not yet on the computer. You can then create a new client/patient by selecting the new 
client/patient button in the toolbar: 
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If a new client or patient is created then the existing name from the import file will be used as 
the default names. These can be changed if required.  
When the Client and Patient names have been selected or created, click the Import button. The 
data will be imported and can be seen in the Practice Management sidebar. Click the refresh 
button if the data does not appear automatically. 
 

 

Refresh Icon 
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